## REVISION CONTROL

<table>
<thead>
<tr>
<th>Document Title:</th>
<th>O2016 Outlook PC Basics – Staff - QRG.docx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author:</td>
<td>Campus Training</td>
</tr>
<tr>
<td>File Reference:</td>
<td></td>
</tr>
</tbody>
</table>

### Revision History

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Revised By</th>
<th>Summary of Revisions</th>
<th>Section(s) Revised</th>
</tr>
</thead>
<tbody>
<tr>
<td>6/24/2015</td>
<td>T. Sherman</td>
<td>Created document</td>
<td>Click here to enter Revision Date</td>
</tr>
<tr>
<td>10/29/2015</td>
<td>A. Fontenot</td>
<td>Revised screenshots and more</td>
<td></td>
</tr>
</tbody>
</table>

### Review / Approval History

<table>
<thead>
<tr>
<th>Review Date</th>
<th>Reviewed By</th>
<th>Action (Reviewed, Recommended or Approved)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/29/2015</td>
<td>Anissa Fontenot</td>
<td>Reviewed</td>
</tr>
</tbody>
</table>
# Table of Contents

1.0 Introduction .............................................................................................................. 5

2.0 Getting Started ......................................................................................................... 5
   2.1 Configuring Outlook ................................................................................................. 5
   2.2 Accessing Outlook ................................................................................................... 7

3.0 Outlook Overview ..................................................................................................... 8
   3.1 Ribbon .................................................................................................................... 8
   3.2 Quick Access Toolbar ............................................................................................ 9
   3.3 Folder Pane ............................................................................................................ 9
   3.4 Navigation Bar ....................................................................................................... 9
   3.5 Status Bar ............................................................................................................... 9

4.0 Mail ........................................................................................................................... 10
   4.1 Creating and Sending Email .................................................................................. 10
   4.2 Attatching files ..................................................................................................... 11
   4.3 Receiving and Reading Messages .......................................................................... 12
   4.4 Responding to messages ...................................................................................... 13
       4.4.1 Replying to Messages ...................................................................................... 13
       4.4.2 Forwarding Messages ...................................................................................... 13
   4.5 Working with attachments .................................................................................... 14
   4.6 Deleting Messages ............................................................................................... 15
   4.7 Restoring Deleted Messages ................................................................................ 15
   4.8 Emptying Deleted Items Folder ............................................................................ 16
   4.9 Printing Messages .................................................................................................. 17
   4.10 Creating Signatures ............................................................................................. 17
       4.10.1 Creating Signatures for New Messages ....................................................... 18
       4.10.2 Creating Signatures for Replies and Forwards ........................................ 19
   4.11 Setting up Automatic Replies ............................................................................ 21
   4.12 Turning off Automatic Replies ........................................................................... 22

5.0 Calendar ...................................................................................................................... 22
   5.1 Viewing your Calendar .......................................................................................... 23
   5.2 Scheduling appointments ...................................................................................... 24
       5.2.1 Scheduling an Individual Appointment ...................................................... 24
       5.2.2 Scheduling a Recurring Appointment ....................................................... 25
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.3</td>
<td>Updating Appointments</td>
<td>26</td>
</tr>
<tr>
<td>5.4</td>
<td>Deleting Appointments</td>
<td>26</td>
</tr>
<tr>
<td>5.5</td>
<td>Sharing your calendar</td>
<td>27</td>
</tr>
<tr>
<td>5.6</td>
<td>Printing your calendar</td>
<td>28</td>
</tr>
<tr>
<td>5.7</td>
<td>Scheduling Meetings</td>
<td>29</td>
</tr>
<tr>
<td>5.7.1</td>
<td>Scheduling Individual Meetings</td>
<td>29</td>
</tr>
<tr>
<td>5.7.2</td>
<td>Scheduling Recurring Meetings</td>
<td>30</td>
</tr>
<tr>
<td>5.8</td>
<td>Updating Meetings</td>
<td>32</td>
</tr>
<tr>
<td>5.9</td>
<td>Canceling Meetings</td>
<td>33</td>
</tr>
<tr>
<td>5.10</td>
<td>Responding to Meeting Requests</td>
<td>34</td>
</tr>
<tr>
<td>5.10.1</td>
<td>Accepting A Meeting Request</td>
<td>34</td>
</tr>
<tr>
<td>5.10.2</td>
<td>Tentatively Accepting a Meeting Request</td>
<td>35</td>
</tr>
<tr>
<td>5.10.3</td>
<td>Declining a Meeting Request</td>
<td>36</td>
</tr>
<tr>
<td>5.10.4</td>
<td>Proposing a New Times</td>
<td>37</td>
</tr>
<tr>
<td>6.0</td>
<td>Email Related Policies</td>
<td>39</td>
</tr>
<tr>
<td>7.0</td>
<td>Getting Help</td>
<td>39</td>
</tr>
</tbody>
</table>
1.0 Introduction

Microsoft Outlook is the official email system for CSUB. Outlook allows you to send and receive messages, schedule appointments, manage tasks, work with your address book, and organize your mailbox. With Outlook, you can access Outlook from most devices, using the desktop, mobile, or web apps.

This guide is designed for use with the Outlook desktop app. It will assist you with performing basic tasks using the Outlook features.

2.0 Getting Started

Getting started with Outlook is a process. The process begins with you setting up your account on Office 365. Next, you will need to setup and configure Outlook to access your Office 365 account.

2.1 Configuring Outlook

In this step, you will setup and configure Outlook to access your Office 365 account.

1. To begin, click the Outlook icon on your desktop

2. On the Ribbon, click File

3. Under Account information, click Add Account

4. On the Add Account page,
   - In the Your Name, type your name
   - In the E-mail Address:, type your email address (netid@csub.edu)
   - In the Password, enter your password
   - In the Retype Password, enter your password
   - Click Next
   
   Your temporary password is case-sensitive. So be sure to enter it as

6. On the Windows Security screen,
   - Enter your password
   - Click OK
   
   This screen may appear under other windows on your desktop. As such, it is recommended that you close or minimize other windows. Your email address should be populated on the screen.

7. When Outlook completes your account setup, you will receive a message indicating account success. Click Finish to complete the process.

8. You will receive a message to restart Outlook. Click OK.

9. If necessary, close Outlook, using the X.
10. Restart Outlook by clicking the Outlook icon on your desktop

11. On the Windows Security,
   - Enter your password
   - Click OK

12. Outlook opens.

2.2 Accessing Outlook

These instructions will guide you in accessing Outlook from your personal computer or laptop.

1. Click the Outlook icon on your desktop

2. On the Windows Security,
   - Enter your password
   - Click OK
3. Outlook opens.

3.0 Outlook Overview

Outlook has several modules to assist you with communicating with others, scheduling appointments, and many other activities. The modules include Mail, Calendar, People, Tasks, Notes, and Folders. This list below describes briefly the functions of these tools.

- **Mail**: Send and receive messages.
- **Calendar**: Schedule appointments and meetings.
- **People**: Maintain your contacts or your address book.
- **Tasks**: Create To Do list with due dates and more information.
- **Notes**: Create notes or lists of information.
- **Folders**: Access and organize your messages and other information.

3.1 Ribbon

The Ribbon contains context sensitive functions for each Outlook module or tool. Groups are used to organize related functions.

For example, the Home tab has the groups: New, Delete, Respond, Quick Steps, Move, Tags, Find, and Send/Receive. Within each group are buttons that perform different actions, such as New EMail will open a new email.
3.2 Quick Access Toolbar

The Quick Access Toolbar is a customizable menu. You can select your most commonly used functions and add them to this toolbar. Once added to the toolbar, you can quickly access these functions. For example, you can add the print and preview option.

3.3 Folder Pane

The Folder Pane is located on the left-hand side of the screen. From this pane, you can view your Inbox, access your Sent Items, or empty your trashcan.

3.4 Navigation Bar

The Navigation Bar is located at the bottom. From the Navigation Bar, you can move between the Outlook modules, such as the Calendar and Tasks. Note there are two different ways to view the navigation bar. By default, Outlook is set to display the Compact Navigation bar shown below.

If you prefer the expanded view shown below, click the , select Navigation Options, and uncheck Compact Navigation.

3.5 Status Bar

The Status Bar provides information and additional capabilities depending on the module you are using.
• **Status Message**
  In the Mail module, the Status Bar displays information about your messages. For example, the Status Message can show the number of mail items in your inbox. In this case, there is one email, which is unread.

• **Folder Pane Button**
  The Folder Pane button opens the Folder pane.

• **Reading Pane**
  The Reading Pane button closes the Folder pane allowing you more room for previewing your email messages.

• **Zoom Scale**
  The Zoom Scale allows you to zoom in and out on the text in your preview pane. The + zooms in (text gets larger) and the – zooms out (text gets smaller).

### 4.0 Mail

This section covers the Mail module. From the Mail module, you can send and receive, work with, and manage your emails. By default, Outlook opens to the Mail module. However, you can access the Mail module by clicking the Mail icon or the word Mail on the Navigation Bar.

**or**

![Mail Icon]

### 4.1 Creating and Sending Email

These instructions will assist you with creating and sending an email.

1. From the Home tab, click **New Email**

2. In the **To** field, type the person’s name or email address.
   
   *You can click the To button to search for their email address.*

3. (Optional) In the **Cc.** field, type the person’s name or email address that you would like to carbon copy.
   
   *You can click the CC button to search for their email address.*
4. In the **Subject**, type the subject of your email.

5. In the body, type your email message.

6. When satisfied, click the Send button.

### 4.2 Attaching files

You can easily attach documents to your email. You can either drag and drop the file to the body of your message or use the Attach File button. These instructions will guide you in attaching a file using the Attach File button.

1. **From the Message tab, click Attach button**

2. Select from the Recent Items list or click **Browse this PC**

3. **On the Insert File,**
   - Navigate to the desired file
   - Select the file
   - Click **Insert**
4. Once the file is attached, you can attach more files, if desired.

4.3 Receiving and Reading Messages

When you receive messages, they will appear in your Inbox. From your Inbox, you can read and preview your messages. These instructions will guide in receiving and reading your emails.

1. Your messages will appear in your Inbox

2. There are two methods for reading your emails.
   Method 1
   - You can select it and
   - Read it from the preview pane

3. Method 2
   - You can double-click the email and it will open in a different window
4.4 Responding to messages

You can respond to your emails from your inbox by opening the email or from the preview pane. Your options for responding to messages include replying, replying to all, and forwarding. These instructions will guide you in responding from an open email.

- **Reply**
  Your response is sent to sender

- **Reply All**
  Your response is sent to everyone addressed on the email

- **Forward**
  Your response is sent to the person you select.

4.4.1 Replying to Messages

These instructions will guide you in replying to messages.

1. From your Inbox, open the email you want to reply to.

2. Click Reply or Reply All

3. When the new email opens,
   - Type your reply in the space above the original message
   - Click Send

4.4.2 Forwarding Messages

These instructions will guide you in forwarding messages.

1. From your Inbox, open the email you want to forward.
2. Click Forward

3. When the new email opens,
   - In the To, enter the recipients name or email address
   - Type your reply in the space above the original message
   - Click Send

4. When an email contains an attachment, you will see a paperclip icon. Double-click the email to open it.

5. Double-click the attachment to open it.

6. The attachment opens in a new window.

7. For additional options,
   - Right-click the attachment
   - Select an option from the pop-up menu
   - Follow the screen directions, if applicable.

4.5 Working with attachments

When you receive an attachment, you can preview, open, quick print, save, copy, or remove it. These instructions will guide in working with attachments.
4.6 Deleting Messages

You can delete an email message from your Inbox or while the email is open. These instructions guide you deleting an email from your Inbox.

1. From your Inbox, select the email you would like to delete.

2. On the Home tab, click Delete

3. The message disappears from your Inbox.

   When you delete an email message, the message is moved to your Deleted Items folder. If you inadvertently delete an email message, you can retrieve it from this folder, provided you have not emptied the folder.

4.7 Restoring Deleted Messages

When you delete an email message, the message is moved to your Deleted Items folder. If you inadvertently delete an email message, you can retrieve it from this folder, provided you have not emptied the folder. These instructions will assist you in restoring a deleted email message.

1. From your Inbox, click the Deleted Items folder in the Folder Pane.

2. From the Deleted Items folder, right-click the email message
3. From the menu,
   - Click Move
   - Click Other Folder…

4. On the Move Items window,
   - Click Inbox
   - Click OK

5. Your email message is moved back to your Inbox.

4.8 Emptying Deleted Items Folder

When you delete messages, they are moved to your Deleted Items Folder. They remain in the folder until it is emptied. These instructions will guide you in emptying your Deleted Items folder.

1. To begin, right-click Deleted Items
2. From the pop-up menu, click Empty Folder. Once the items are deleted, they cannot be recovered.

4.9 Printing Messages

On occasion, you may want to print an email message. The common method is using the File menu from an open email message. These instructions will walk through this process.

1. While the email is open, click the File tab.

2. When the menu opens, click Print
   *Note: If you need to go back to the previous page, click the arrow in the top left corner

3. On the Print screen,
   - Use the drop down to select the desired printer, if necessary
   - Click Print

4.10 Creating Signatures

An email signature is the block of text that is added to the end of your email message. Typically, it contains your contact information, such as name, title, department, business address, phone number, fax number, and email address. You can have signatures for new messages and for replies and forwards.
4.10.1 Creating Signatures for New Messages

When creating signatures for new messages, you can specify whether your signature applies to new messages, to replies and forwards, or to both. These instructions will guide you in creating a signature for new messages.

1. To begin, click the File tab.

2. Click Options

3. On the Outlook Options screen, click Mail

4. Click Signatures

5. On the E-mail Signature tab, click New

6. On the New Signature screen,
   - Type a name for the signature
   - Click OK

7. In the Edit Signature box,
   - Type your signature text
   - If desired, use the formatting button to change the font, font size, and font style.
8. From the Choose default signature,
   - In the New messages, click the down arrow and select your signature (i.e. Signature – New Messages)
   - Click OK

9. To finish, click OK

10. The next time you compose an email, your new signature will appear.

### 4.10.2 Creating Signatures for Replies and Forwards

You can have different signatures for your new messages and for replies and forwards. You can specify which signature to use when. These instructions will guide you in creating a signature for replies and forwards.

1. To begin, click the File tab.

2. Click Options

3. On the Outlook Options screen, click Mail
4. Click Signatures

5. On the E-mail Signature tab, click New

6. On the New Signature screen,
   - Type a name for the signature
   - Click OK

7. In the Edit Signature box,
   - Type your signature text
   - If desired, use the formatting button to change the font, font size, font color, and font style.

8. From the Choose default signature,
   - In the Replies/forwards, click the down arrow and select your signature (i.e. Signature – Replies and Forwards)
   - Click OK

   Notice you have the option to select any of your signatures.

9. To finish, click OK
10. The next time you reply to or forward an email, your new signature will appear.

4.11 Setting up Automatic Replies

You can set up automatic email replies, such as when you are away on vacation or business. The process involves creating a template and a rule. These instructions cover the steps involved.

1. Click File

2. On the Account Information page, click Automatic Replies

3. On the Automatic Replies page,
   - Click Send automatic replies
   - Check only send during this range
   - Select the start date and time
   - Select the end date and time

4. On the Inside My Organization tab, type your message

5. (Optional) If you don’t want to reply automatically to email from people outside of CSUB, then
   - Click the Outside My Organization tab
   - Uncheck Auto-reply to people outside my organization, if desired
6. (Optional) If you don’t want to reply automatically to email from people outside of CSUB, then
   - Click the Outside My Organization tab
   - Check my Contacts only or Anyone outside my organization
   - Type your message

7. When you are finished, click OK

8. Click the button, to return to your Inbox

### 4.12 Turning off Automatic Replies

These instructions cover turning off automatic replies.

1. Click File

2. On the Account Information page, **Turn off**

3. Click the button, to return to your Inbox

### 5.0 Calendar

This section covers the Calendar module. From the Calendar module, you can create and manage your appointments. You can view your calendar in daily, weekly, and monthly formats. Additionally, you can create meetings and invite people to attend. The integration between the Calendar and Mail modules allow you to send and forward appointments and to mail your calendar to others.

To access the Calendar module, click Calendar on the navigation bar (bottom of screen)
5.1 Viewing your Calendar

You can display your calendar in a number of ways. You can display it as a daily, weekly, or monthly view. Additionally, you view it based on the work week or as schedule. To change your calendar view, click the desired icon on the Home tab.

<table>
<thead>
<tr>
<th>Calendar Views</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Displays your appointments by time for the selected day</td>
</tr>
<tr>
<td>Work Week</td>
<td>Displays your appointments by day and time for your work week, such as Monday through Friday</td>
</tr>
<tr>
<td>Week</td>
<td>Displays your appointments by day and time for the week (Sunday through Saturday)</td>
</tr>
</tbody>
</table>
Month

- Default view
- Displays your appointments for the month including weekends

Schedule View

- Displays your appointments for the day by time in an horizontal format with an availability status bar
- This view is helpful, when working with more than calendar

5.2 Scheduling appointments

The Calendar module allows you to schedule individual and recurring appointments. You can specify the subject, location, duration, appointment information. Additionally, you choose how the appointment will appear on your calendar and when to be reminded about your appointments.

5.2.1 Scheduling an Individual Appointment

An individual appointment creates a single entry on your calendar for an event, such as a meeting, conference, etc. These instructions will help you with creating an individual appointment.

1. From the Calendar Home tab, click **New Appointment**

2. In the **Subject** field, type subject of your appointment

3. In the **Location** field, type the location for your appointment

4. In the **Start time**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

5. In the **End time**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time
6. In the body, type the appointment information, such as purpose and the agenda.

7. When satisfied, click the **Save & Close** button.

### 5.2.2 Scheduling a Recurring Appointment

A recurring appointment creates multiple entries on your calendar for a single event, such as monthly department meetings, vacation, etc. These instructions will help you with creating a recurring appointment.

1. From the Calendar Home tab, click **New Appointment**

2. In the **Subject** field, type subject of your appointment

3. In the **Location** field, type the location for your appointment

4. In the **Start time**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

5. In the **End time**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

6. In the body, type the appointment information, such as purpose and the agenda.

7. On the **Appointment** tab, click **Recurrence**.
8. On the Appointment Recurrence,
   - Select a recurrence pattern, such as Monthly
   - Specify the frequency, such as The Second Monday of every 1 month
   - Select the ending date, such as End after 10 occurrences
   - Click OK

9. When satisfied, click the Save & Close button.

5.3 Updating Appointments

You can quickly update your appointments from your calendar or by opening your appointments. These instructions will guide you in opening your appointments for updating.

1. From your Calendar, double-click the appointment you would like to update.

2. If you open a recurring appointment, you will receive a similar message.

   You can either update the one appointment occurrence or update the entire series. Once you make your selection, click OK

3. When the appointment opens, make the desired changes.

4. When satisfied, click the Save & Close button to save your changes.

5.4 Deleting Appointments

From your calendar, you can delete appointments quickly. These instructions will assist you in an appointment from your calendar.
1. From your Calendar, select the appointment you would like to delete.

2. If you open a recurring appointment, you will receive a similar message.

   You can either delete the one appointment occurrence or delete the entire series. Once you make your selection, click OK.

3. From the Appointment tab, click the Delete icon.

4. The appointment disappears.

5.5 Sharing your calendar

You can share your calendar with other people at CSUB. You also can specify how much of your calendar to share.

1. In the folder pane and under My Calendars, right-click the calendar you want to share.

2. From the menu, click Share

3. Click Share Calendar
4. On the Share tab,
   - In the To, enter the person’s name or click To search for the person
   - In the Subject, you can change the text or leave it
   - (Optional) Check the Request permission to view recipient’s Calendar
   - Leave the Allow recipient to view your Calendar checked
   - In the Details, select an option. Your choices are Availability only, Limited details, and Full details.
   - (Optional) In the body, enter your comments
   - Click Send

5. On the message screen, click Yes


5.6 Printing your calendar

You can print your calendar from any view. To print your calendar, follow these instructions.

1. Click File

2. In the folder pane, click Print
3. On the Print screen,
   - Select a printer
   - Under Settings, select a layout style
   - Click Print

   The preview shows how your calendar will print.

5.7 Scheduling Meetings

Scheduling meetings is similar to scheduling appointments. The main differences between scheduling meetings and appointments are the additional tasks for inviting participants and scheduling meeting rooms. Additionally, scheduling a meeting will send a meeting request to the selected attendees. Like appointments, you can schedule individual or recurring meetings.

Please note that 25Live is the primary event scheduling application for reserving rooms, such as class rooms, labs, large venues, and some conference rooms. As such, the meeting rooms referred to in this section are ones that are not used by 25Live, such as private conference rooms i.e. ADM 101, etc.

5.7.1 Scheduling Individual Meetings

An individual meeting creates a single entry on your calendar for an event, such as a meeting, conference, etc. These instructions will help you with creating an individual meeting.

1. From the Calendar Home tab, click New Meeting

2. Click the To... button

3. On the Select Attendees and Resources: Contact page,
   - Select the desired attendee, such as Benjamin Franklin
   - Click Required
   - Repeat to add additional attendees
4. To add the room,
   - Select the desired room
   - Click Resources
   - Click OK

5. In the **Subject** field, type subject of your appointment

6. In the **Start time**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

7. In the **End time**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

8. In the body, type the meeting information, such as purpose and the agenda.

9. When satisfied, click the **Send** button.

   *A meeting request will be sent to the selected participants.*

### 5.7.2 Scheduling Recurring Meetings

A recurring meeting creates multiple entries on your calendar for a single event, such as monthly department meetings, etc. These instructions will help you with creating a recurring meeting.

1. From the Calendar Home tab, click **New Meeting**
2. Click the To… button

3. On the Select Attendees and Resources: Contact page,
   - Select the desired attendee, such as Benjamin Franklin
   - Click Required
   - Repeat to add additional attendees

4. To add the room,
   - Select the desired room
   - Click Resources
   - Click OK

5. In the Subject field, type subject of your appointment

6. In the Start time,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

7. In the End time,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

8. On the Meeting tab, click Recurrence
9. On the **Appointment Recurrence**,  
   - Select a recurrence pattern, such as *Monthly*  
   - Specify the frequency, such as *The Second Monday* of every 1 month  
   - Select the ending date, such as *End after 10 occurrences*  
   - Click OK

10. In the body, type the meeting information, such as purpose and the agenda.

11. When satisfied, click the **Send** button.  

   *A meeting request will be sent to the selected participants.*

### 5.8 Updating Meetings

You can quickly update your meetings from your calendar or by opening your meetings. These instructions will guide you in opening your meetings for updating.

1. From your Calendar, double-click the meeting you would like to update.

2. If you open a recurring meeting, you will receive a similar message.  

   *You can either update the one meeting occurrence or update the entire series. Once you make your selection, click OK*
3. When the meeting opens, make the desired changes.

4. When satisfied, click the Send Update button to save your changes and email the updated meeting request to the participants.

5.9 Canceling Meetings

From your calendar, you can cancel meetings quickly. These instructions will assist you in cancelling a meeting from your calendar.

1. From your Calendar, select the meeting you would like to cancel.

2. If you open a recurring meeting, you will receive a similar message.

   You can either cancel the one meeting occurrence or cancel the entire series. Once you make your selection, click OK.

3. From the Meeting tab, click the Cancel Meeting icon.

4. If desired, you add a reason for the meeting cancellation.
5. When satisfied, click **Send Cancellation** to send the cancellation message to your attendees.

6. The meeting disappears.

### 5.10 Responding to Meeting Requests

Meeting requests will appear in your Outlook Inbox. You can quickly respond to the message from your preview pane. You have several options when responding to meeting requests. You can accept, accept tentatively, and decline. Additionally, you can accept tentatively and propose a new time or decline and propose a new time.

#### 5.10.1 Accepting A Meeting Request

You can accept a meeting request from your preview pane. When responding you will have the choice to make a comment before sending, to send the response immediately, or not to send a response. These instructions will guide you in tentatively accepting a meeting request.

1. From your Inbox select the meeting request you would like to respond to.

2. From the Preview Pane, select Accept

3. From the Accept menu, select the desired option.
4. If you selected, Edit the Response before Sending,
   - Add your comments
   - Click Send

5. After responding, the meeting request will disappear from your Inbox. The meeting will appear on your calendar, showing the date and time of your acceptance.

6. The meeting initiator will receive your response in their Inbox.

5.10.2 Tentatively Accepting a Meeting Request

You can tentatively accept a meeting request from your preview pane. When responding you will have the choice to make a comment before sending, to send the response immediately, or to not send a response. These instructions will guide you in accepting a meeting request.

1. From your Inbox select the meeting request you would like to respond to.

2. From the Preview Pane, select Tentative

3. From the Tentative menu, select the desired option.
4. If you selected, Edit the Response before Sending,
   • Add your comments
   • Click Send

5. After responding, the meeting request will disappear from your Inbox. The meeting will appear on your calendar, showing the date and time of your tentative acceptance.

6. The meeting initiator will receive your response in their Inbox.

5.10.3 Declining a Meeting Request

You can decline a meeting request from your preview pane. When responding, you will have the choice to make a comment before sending, to send the response immediately, or not to send a response. These instructions will guide you in declining a meeting request.

1. From your Inbox select the meeting request you would like to respond to.

2. From the Preview Pane, select Decline

3. From the Decline menu, select the desired option.
4. If you selected, Edit the Response before Sending,
   - Add your comments
   - Click Send

5. When you decline a meeting request, the request disappears from your Inbox and it does not appear on your calendar.

6. The meeting initiator will receive your response in their Inbox.

5.10.4 Proposing a New Time

You can respond to your meeting requests from your preview pane. When responding, you propose a new time, while accepting tentatively or declining. These instructions will guide you in proposing a new time.

1. From your inbox, select the meeting request.

2. In the preview pane, select Propose New Time.

3. From the Propose New Time menu, select the desired option.

4. On next screen,
   - Make your changes
   - Click Propose Time
5. Next,
   - Add comments, if desired
   - Click Send

6. If you declined the request and proposed a new time, the meeting request will not appear on your calendar. If you accepted tentatively and proposed a new time, the meeting request will appear on your calendar.

7. The meeting initiator will receive your response in their Inbox.
6.0 Email Related Policies

CSU Bakersfield has several policies that relate to email and other sensitive data. The list below are a few of the policies involved with email.

- Email Policy
  http://www.csub.edu/its/about/security/supplemental/email/index.html

- Email Blocking Policy and Procedures
  http://www.csub.edu/its/about/policies/tech/emailblock/index.html

- Confidentiality of Email Policy
  http://www.csub.edu/its/about/policies/tech/emailpolicy/index.html

- Instant Messaging Policy
  http://www.csub.edu/its/about/security/supplemental/instantmessage/

For more information, visit the Information Security website at:
http://www.csub.edu/its/about/security/index.html

7.0 Getting Help

If you are unsure or need assistance, please refer to the resources below:

- Resources on the Web
  Outlook 2016
  www.csub.edu/training/pgms/outlookp/index.html

- For general training questions
  Tammara Sherman, Ed.D.
  Campus Training
  661-654-6919
tsherman@csub.edu
  www.csub.edu/training/index.html

- For help with computer-related Issues
  Help Desk
  661-654-2307
  helpdesk@csub.edu